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INTRODUCTION TO COMPUTER
Computer
Computer is an electronic device which converts raw data to provide useful information
under control of a program. So, computer is a device that computers at very high speeds.
Data – Data are raw facts and figures which describe any entity or object of real world. Like
name, numbers, date etc.
Information – Processed data which can be used to take decisions is known as information.
Program – A meaningful and computer set of instructions given to computer.
Processing – Any mathematical or logical operation done on data.
Figure of a Computer

Characteristics of a Computer


Speed – Computer works at very high speed. Many calculations are done within a
fraction of second.



Accuracy – If programmed correctly computer gives accurate result every time.



Diligence – Computer never gets bored on tired. It can work for many hours and can
perform repeated task with same efficiency.



Automatic – Once if we start a task computer completes it on its own, hence it is
called automatic



Storage – Large amount of data can be stored in computer‟s memory.



Multi-tasking – Computers can be used to perform a variety of tasks such as word
processing, calculations, graphics etc.



Zero IQ – A computer cannot think on its own. It does whatever is written in
program.

History
The concept behind Computer has been evolving with mankind since we needed a tool to
help in calculations. Following devices led to development of computers –
1.
Abacus – Chinese people in 500 BC invented abacus using wires and beads to help in
calculations. It is a mechanical device for addition, subtraction, multiplication and
devision of numbers.
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Jacquard’s loom – Joseph Jacquard, a French weaver used punched cards and blocks
to store weaving patterns. He gave an idea that data and information can be stored.
3.
The Adder – In 1642, Blase Pascal designed a mechanically operated machine that
could add and substract number till eight digits.
4.
Leibniz calculator – Leibniz improved Pascal‟s machine for multiply, divide and
other operations.
5.
Difference Engine – Designed in 1823 by Charles Babbage it was a mechanical
device to perform multi-step complex calculations. Babbage is known as Father of
Computers.
6.
Analytical Engine – Babbage designed this in 1830 as a mechanical but
programmable machine. It had a processing unit, a memory and various input-output
devices.
Von Neumann – In 1940, John Von Neumann introduced use of binary digits and the stored
program concept.
2.

Analytical Engine

Basic Computer System
A computer system comprises of three integral components which cannot be separated.
1.
Software – Software is a set of programs which work together. It is intangible part of
the computer system. It is essential so that a computer can be used for a specific realworld application.
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Hardware – All physical, mechanical and electronic parts of the computer system
form the Hardware. It is the tangible part of the system.
3.
User – User uses the computer machine and hence is a part of the system. It is
basically anyone or anything for which computer does work.
John Von Neumann proposed an architecture which is still followed in computers. A
computer is considered as a system which takes some input and gives some output. It does
processing on the input according to a set of instructions called programme which is stored in
its memory. This is also called the stored program concept or Von-Neumann Architecture.
2.

Basic Computer Architecture

Input Devices
The devices which are used to feed data and instructions into computer are called input
devices. These devices convert input data into computer acceptable form. Keyboard and
mouse are most common input devices and there are several more.
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Output Devices
The devices which are used to take output of information in any form from computer are
called output devices. They produce the processed information. They convert output
information into user readable form. The monitor or screen and printer are most common
output devices.

Storage Devices
Computer requires some space to store data and instructions. The devices attached to
computer for storing the programs and data are called storage devices. The data can be stored
and then later retrieved from these devices. It may be external or internal.

CPU
The part of computer which does all processing and control is called processor or Central
Processing Unit. It is the brain of computer and controls all input, output and storage
devices. It consists of two parts, the Control Unit and The Arithmetic Logic Unit.

Some Common Computer Input Devices :
1. Keyboard




Used to type data into the computer
Most common input device today
Has some special keys also for giving the computer commands

Keyboard
2. Pointing Devices
 Pointing devices move some object on the screen and can do some action
 Common pointing devices
*
Mouse – most common pointing device. It is held in one hand and moved
across a flat surface. By moving the mouse and clicking, you can select an item, or
per form any other action. It generally has two buttons – left and right. Sometimes, a
middle button or scroll wheel is provided. Mouse can be mechanical, working with
two wheels and ball, or optical which uses light beams.
To Start A New Study Centre Under AIYCSM Call 9830654959 or Log in to
www.aiycsmindia.org

4

All India Yuva Computer Saksharata Mission

*

*

Mechanical Mouse
Optical Mouse
Track ball – basically an upside down mouse. The user spins the ball in
different directions to move the cursor on the screen.

Track ball
Joystick – It is generally used for playing games. It
is also a pointing device. The stick can be moved
in all directions.

*
Light Pen – A device in shape of pen. It contains light
receptor and is activated by pressing it against display screen.
It basically imitates motion of hand.
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3. Scanner
A scanner allows you to scan documents, pictures
or graphics and view them on the computer. You
can also use software to edit the items you scan.
 Used to put printed pictures and text into a
computer
 Converts an image into does that the
computer can understand
 To scan text, optical character recognition
(OCR) software is needed.

4. Microphone
 Used to put sound into a computer
 Need sound recording software

Some Common Output Devices :
1. Monitors and Displays



Shows the processed information on a screen.
A monitor uses a Picture Tube like a television
with the image displayed on the front of the tube,
which is called the screen.

CRT Monitor


Displays are flat and use plasma, LCD, activematrix, or some other technology.

LCD Monitor
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Monitors used to be called Cathode Ray Tubes (CRTs) because of the picture tube,
which is a large vacuum tube.

2. Printers




Printers produce a hard copy.
The information is printed on paper and can be used when the device is off.
It is also called a printout.

 Dot-matrix printers (input printer)

* Uses metal pins to strike an inked ribbon to make
dots on a piece of paper.
* Can see the dots that make up the letters or
images.
* Lowest print quality of all of the printers.
Dot Matrix
* Very low in cost per page to use.
Printer
* Rarely used today because of the poor print quality, but still used in business to print
multi-part forms.

 Ink jet printers (non-impact printer)






Use drops of magnetic ink to
produce dots on a page to
produce next or images.
Problems with the ink
(i)
The ink is very expensive
(ii)
The ink is water soluble
and will run if the paper
gets wet
Highest cost per page of all the
printers
For producing color documents,
it has the highest quality at a reasonable price.

Ink jet printers

Laser printers (non-impact printer)


How the laser printer produces an image
(i)
A laser or LED make dots on a light sensitive drum
(ii)
Toner (very tiny particles of plastic) stick to the drum where the dots where
made
(iii)
Paper is pressed against the drum and the toner is placed on the paper
To Start A New Study Centre Under AIYCSM Call 9830654959 or Log in to
www.aiycsmindia.org

7

All India Yuva Computer Saksharata Mission




(iv)
The paper is heated and the toner melts into the paper
Produces the highest quality printout
For black and white printouts, very low cost per page

Laser Printer

3. Speakers
used to output sound
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System Unit
A computer system unit contains many parts.

Motherboard – The motherboard is the main circuit board of a microcomputer. It is also
known as the mainboard or system board.
CPU – The CPU is the central electronic chip that determines the processing power of the
computer.
Memory – Memory is the part of the computer that temporarily stores applications,
documents and stem operating information.
Bus – A bus is an electronic line that allows 1s and 0s to move from one place to another.
Expansion Slots – Expansion slots appear on the motherboard. They are sockets into which
adapters are connected.
Ports and Connectors – A port is a connector located on the motherboard or on a separate
adapter.
Bays – A bay is a space inside the computer case where a hard drive, floppy drive or CDROM drive sits.
Power Supply – A power supply changes normal household electricity into electricity that a
computer can use.
Sound Components – A sound card lets a computer play record high quality sound.
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Central Processing Unit (CPU)

Microprocessor Chip
Does all of the work for the computer
1.
Does all of the mathematics, mainly addition.
2.
Does all the logical comparisons of values.
3.
Directs the flow of data in a computer.
4.
Controls the operation of the parts of the computer.
5.
A microprocessor is a complete computer on a silicon chip.
6.
A microprocessor does all of the functions of a computer.
(i)
stores data and instructions waiting to be used.
(ii)
follows changeable instructions.
(iii)
does input, processing and output.

CPU have three basic parts
1.

The Arithmetic Logic Unit (ALU)
i
does all of the mathematics in a computer.
ii
does all of the logic comparisons of values.
iii
does all mathematical operations in form of additions.

2.

The Control Unit
i
directs the flow of information into the CPU and/or memory or storage.
ii
controls which instructions the CPU will do next.

3.

Registers
i
ii

Used to store data and instructions inside the processor.
Size of the registers can affect the speed and performance of the processor.

Speed of CPUs
The speed of CPUs is measured in hertzs. A hertz is one cycle per second. All computers
have a clock built into them for timing the cycles. The clock is usually located in a small
metal box on the motherboard. Today, many CPUs can complete over six (6) instructions per
second. Most computers have a CPU that can do more than 400 MHz. A MHz is 1,000,000
cycles per second. Computers will soon be at speeds of over a gigahertz, 1,000,000,000
Hertz.
To Start A New Study Centre Under AIYCSM Call 9830654959 or Log in to
www.aiycsmindia.org

10

All India Yuva Computer Saksharata Mission

Memory
Computer memory is classified into two types
1. Main Memory – Also called primary memory. It is attached to the processor, and
CPU cannot work without it. It contains the data and programs which are in current
use of computer.
2. Secondary Memory – It is a large memory used for storing things for future use. It is
not used directly by CPU. Anything to be used is first copied from Secondary to Main
Memory and then used.

Primary memory
It can be used directly by the CPU. It has following features :
1. Consists of silicon chips, usually VLSI technology is used to create the chips
2. Two forms of Primary Memory :
(i)
Read Only Memory (ROM)
(ii)
Random Access Memory (RAM)
3. Primary memory is also called primary storage or main memory

Read Only Memory (ROM)
1.
Stores instructions that are used by the
CPU.
i
Tells the CPU how to be the kind of
computer it is, for example a Windows,
Mascintosh, or Play Station computers.
ii
Tells the CPU how to work with the
A ROM IC
different parts of the computer.
iii
ROM can also hold programs that are directly accessed by the CPU. One such
program is the self-test when the computer is first turned on. The self-test tests to
seem if all the parts on the main circuit board (mother board) are working correctly.
2.
The instructions in ROM can not usually be changed.
i
The instructions are built into the electronic circuits of the chips.
ii
These instructions in ROM are called firmware.
iii
To change the instructions in ROM you need to usually change the chips or do some
other special process that is normally not available to an average user.
3.
The instructions in ROM are nonvolatile. They stay in ROM even when the computer
is turned off.
4.
Access to information is random access.
i
Random access means that any piece of information in ROM can be accessed at any
given time without access other information first. It is a lot like the tracks on a music
CD. You can access any track at any time and in any order.
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ii

The other kind of access is sequential access. You must access the information in the
order that they are located. This is a lot like a music tape. You must play the songs in
order, or you have to fast forward
past songs to get to the one you
want.

Random Access Memory (RAM)
1.

2.
3.

4.

Stores data and instructions that are
used by the CPU to perform some
task.
A RAM Chip
i
These
instructions
are
usually loaded into RAM
from a secondary storage
device.
ii
RAM is also used to store instructions that tell the CPU how to work with its
parts. These instructions are usually called drivers.
The instructions in RAM are constantly changing, depending on the needs of the
CPU.
The instructions in RAM are volatile.
i
When the computer is turned off the information in RAM disappears.
ii
The information in RAM needs to be saved to secondary storage before the
computer is turned off.
Access to information is random access.

Secondary Storage Devices
How a computer stores information ?
1.
i
ii
2.
i
ii
iii

The computer stores information as a string of zeros (0) and ones (1)
The standard string length is eight 0‟s or 1‟s in a row, called a byte
A byte equals one character – a character is a letter, number, or symbol.
Information size measurements
Kilobyte (KB) = 1024 bytes
Megabyte (MB) = 1000 KB
Gigabyte (GB) = 1000 MB
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Some Common Storage Devices
Hard Disk
The hard disk is the primary device that a computer uses
to store information. The hard disk stores programs, data
files, saves files and organizes files. It magnetically
stores data on stacks of rotating disks called platters. It
has great capacity in range of GB. It is not portable.

A Hard Disk

Floppy Disk
The floppy disk is a small magnetic medium of storage with capacity 1.44 MB. It is portable
and small in size. Data can be written as well as read from floppy.

Floppy and CD

CD-ROM
CD-ROM stands for Compact Disk Read Only memory. One CD is equal to the space in over
40 floppy discs. It contains data which can be read using CD-Drive. To write data we need
CD-RW.

Removable Hard Disk
A zip disk is a removable disk that holds a large
amount of information. A zip disk can be used to
achieve, protect and transfer large amounts of data.

Zip Drive & Zip Disk
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Pen Drive
It is a portable device which usually plugs into a USB port. It has
varying storage capacity in range of GB. Data can simply be copied to
or from the pen drive.

Pen Drive

Communications Devices
Specific equipment and programs are needed to connect to the Internet or to communicate
with others computers. You can use any type of computer such as IBM compatible or
Macintosh to connect to the Internet or communicate with other computers. You need special
programs to use the Internet. Most companies that connect you to the Internet provide the
programs you need free of charge. You also need a modem to connect to the Internet. A
modem translates computer information into a form that can be transmitted over telephone
lines. Modems can be used to connect you to the Internet, exchange information and to send
and receive faxes.

Peripheral Devices
A peripheral device is any piece of hardware attached to a computer. A few examples of
peripheral devices are printers, scanners and digital cameras.
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Generations
As fundamental hardware technology of computers evolved, each new generation of
computer had greater speed, larger memory and smaller size.
1.
First Generation (1945-54) – Computers of this generation were marked by
following characteristics :
a.
central control by single CPU.
b.
ferrite core main memory.
c.
use of vacuum tubes which were very large.
d.
punched cards as input device.
e.
magnetic tapes and drums as secondary storages.
f.
machine language and assembly language for programming.
g.
access to one programmer at a time.
Examples – ENIAC, Whirlwind I, EDSAC, UNIVACI
2.
Second Generation (1955-1964) – It started with invention of semi-conductor
technology.
a.
Use of transistors which were very smaller than vacuum tubes.
b.
Floating point arithmetic hardware.
c.
High level programming languages like FORTRAN, COBOL, ALGOL.
d.
Magnetic disk was introduced as storage medium.
Examples – IBM 700, UNIVAC 1108, IBM 1620, IBM 7090
3.
Third Generation (1965-1974) – It was started with era of micro-electronics.
a.
Use of Integrated Circuits (ICs) which had many components like transistors and
capacitors on a single chip. Small Scale Integration (SSI) was used.
b.
Magnetic disks, tapes of greater capacity.
c.
Very low cost, highly reliable, less power consumption and much smaller size.
d.
Use of MICR, scanners and plotters.
Examples – DEC PDP/8, IBM System/360 family.
4.
Fourth Generation (1975-1989) – It started with Very Large Scale Integration
(VLSI) techniques.
a.
Microprocessors were used as CPU.
b.
Parallel processing and multiprocessing.
c.
General purpose software were developed.
d.
Concept of Personal Computers developed.
e.
Semiconductor memories for storage.
VAX-9000, Cray X-MP, IBM 3090
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5.

Fifth Generation (1991 – present) –

a.

Use of Ultra Large Scale Integration (ULSI), gallium-arsenic and optical
technologies.
b.
Intelligent programming, knowledge based problem solving.
c.
Improved human-machine interface.
d.
Target of very high speed, very small size and artificial Intelligence in computers.
Examples – Intel family, Cray Research, Paragon, VPP500

Classification
Broadly, computers are of three categoried :
1.
Analog Computer – These are not the actual computers but devices which
measure some physical quantity or can perform some calculations on them. Like,
thermometer, rain gauge.
2.
Digital Computer – These are the computers working on data as numbers which
is fed systematically and some well-defined operations are performed on it.
3.
Hybrid Computer – These have good features of both analog and digital
computers. They have speed of analog and accuracy of digital. Like, radar system.
Digital computers can be classified based on their size, as following :
1.
Personal Computers – Personal computers are desktop computers designed for
an individual‟s use. They run programs designed to help individuals accomplish their
work more productivity.
2.
Servers – Servers are not designed to be used directly. They make programs and
data available for people hooked up to a computer network, a collection of computers
connected together so that they can exchange data.

Server
3.

Personal Computer

Minicomputers – Minicomputers are multi-user
systems that can handle the computing needs of a
smaller corporation or organization. Many people use
them simultaneously by means of remote terminals or
personal computers.
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Minicomputers

4.

Mainframes – Mainframes are huge, multi-user
systems designed to handle gigantic processing
jobs in large corporations or government agencies.

5.

Supercomputers – Supercomputers are
ultra fast computers designed to process huge
amounts of scientific data then display the
underlying patterns that have been discovered.

Mainframe

Cray
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Software
General Information – Computer software provides instruction that tell the computer
how to operate. Software are also called programs. Programs are usually created using other
software called programming languages.
There are two (2) main types of software

1.

System Software



i
ii

i
ii


2.

Used by the computer to accomplish a task.
Some System Software is built into the computer, like ROM chips and BIOS.
It helps to setup the computer and start it.
What system software does :
controls the internal function of the computer.
controls other devices connected to the CPU.
Operating Systems – The operating system is usually located on a disk. Can be
on either the hard disk drive, a floppy disk, or CD-ROM disk.
Must be loaded into RAM before it can be used.
Used by the computer‟s hardware to work with its parts.
Examples – MS-DOS, Windows, Linux.
The system software that control peripherals are called drivers.

Application Software – These programs work with the operating system software
to help you use your computer to do specific types of work such as word processing to
type a letter.

Used by people to accomplish a specific task.

Some common kinds of application software.
i
Word Processor software.
ii
Database software.
iii
Spreadsheet software.
iv
Games.
v
Web Page Browsers.

Kinds of Software
1.
Public Domain Software
i
ii.
iii.

Has no copyright – no one owns the right to control who can make copies of the
software.
Free to use or make copies of.
Can be copied, used in other programs or changed by anyone.
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2.

Freeware

i

Has a copyright – someone owns the right to determine who can make copies of the
software.
Free to use and make copies of.
Can only give away exact copies of the software.
Can not be changed or used in another program without the copyright holder‟s
permission.

ii
iii
iv

3.

Shareware

i
ii
iii

 Has a copyright.
 Allowed to use the software before paying for it.
Can be demo – which limits some major features like the Save command.
Can set an amount of time you can use the software.
Can trust that you will pay for it if you like the software.
 Can only give away exact copies of the software.
 Can not be changed or used in another program without the copyright holder‟s
permission.

4.

Commercial Software

i
ii

 Has the most resistive copyright.
 Have to buy the software before you can use it.
 Can usually make one copy of the software as a backup copy.
A backup copy is used in case something goes wrong with the original software.
Can not give away or sell the backup copy.
 Can not copy, look at the program‟s code, change, or use the software in another
program without the copyright holder‟s permission.
 Commercial Software is the best software in the world.

How Software is Inputted into Computer
1. Built into the computer‟s circuits, the ROM chips.
2. Loaded into the computer from a secondary storage device, like a floppy disk or
hard disk drive.
3. Typed in from the keyboard.
 Usually need to use a programming language to create the software.
 Rarely done by most computer users today.

User Interfaces
1. The user interface is how the computer‟s operating system presents information to
the user and the user gives instructions (commands) to the computer.
2. There are two kinds of User Interfaces.
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 Text Interface
*
*

Presents information to the user in the form of text.
Have to type in commands or select commands from a menu displayed as text
on the screen.
Hard to use or learn, because the user must memorize and type in commands.
Examples : MS-DOS (MicroSoft Disk Operating System) ProDos
(Professional Disk Operating System)

*
*

 Graphic User Interface (GUI)
*
*

Presents information to the use in the form of pull-down menus and icons.
The user gives commands to the computer by selecting items from a menu or
by clicking on an icon when using a pointing device.
GUIs are easy to learn and use.
Examples : Windows 98/2000, Mac OS.

*
*

Utilities
These allow you to complete certain tasks on your computer. Examples of some of these
tasks are file organizations.
 Specific purpose application software used to help a computer work better or to avoid
problems.
 Some utility programs are built into the operating system.
*
Scandisk in the Windows operating system.
*
Disk formatting software.
 Examples of utility programs.
*
Anti-virus software.
*
Disk maintenance software.

To Start A New Study Centre Under AIYCSM Call 9830654959 or Log in to
www.aiycsmindia.org

20

All India Yuva Computer Saksharata Mission

Maintaining Your Computer System
General Dos and Don’t
Do:







Always shut down your computer properly.
Do regular Scandisk to check the hard disk surface for damage.
Defragment the hard disk periodically.
Delete all files and programs you no longer need from your computer.
Use an anti-virus program to prevent a virus on your computer.
Back up data to floppy disks or zip disks to ensure you have a copy.

Don’t:



Do not eat or drink around the computer.
Do not use magnets around a computer.

Taking Care of disks
Do:




Delete all files you no longer need from your disk.
Use an anti-virus program to scan for viruses on a disk.
Do prevent erasing and recording information on a disk by write-protecting in.

Don’t:






Do not use magnets around a disk.
Do not take a disk apart.
Do not remove the disk while it is in use.
Do not store in extremely hot or cold locations.
Do not spill liquids on the disk.

Cleaning Hardware
Follow instructions in the manual or in help files that came with the computer or other
hardware devices. Before cleaning anything, unplug it from the electrical wall socket.

When to clean a computer
1.
2.
3.

Computers do not need to be cleaned too often if they are kept in a clean environment.
Clean the computer when it looks dirty or when a device (like a mouse) does not work
right.
The two things that need the most cleaning are the screen and mouse.

Cleaning a Monitor’s screen
1.
2.

Wipe the screen with the damp lint-free cloth.
Use a dry cloth to dry the screen.
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3.

You may want to use a used fabric softener cloth to help remove static charges on the
screen.
i
Static charges attract dust to the screen.
ii
A fabric softener cloth has anti-static chemicals on it.
iii
Wipe the screen very lightly with the used fabric softener cloth.
iv
Do not use a fresh fabric softener cloth. It will leave streaks.

Cleaning the Keyboard
1.
2.
3.
4.

Use a slightly damp cotton swab to clean in-between the keys.
Wipe the outside of the keyboard with a damp cloth.
Use compressed air to remove paper pieces and dust from under the keys.
Do not take a keyboard apart to clean it! You may not get it back together again.

Cleaning a Mouse
1.
2.

Clean the outside of the mouse with a damp cloth.
To clean the inside of the mouse.
i
Take the mouse apart.
ii
Turn the mouse upside down.
iii
Rotate the retaining ring until it comes free.
iv
Turn the mouse right-side up and catch the ring and ball in your hand.
v
Use damp cotton swabs to clean the rollers inside the mouse. Be sure to rotate
the rollers to get all of the dirt off of them.
vi
Wash the ball in warm soapy water. Wipe dry with a lint-free cloth.
vii
Blow out the inside of the mouse to remove any dust.
viii
Put the mouse back together after it has dried.

Inside the Computer’s Case
1.

The inside of the computer rarely has to be cleaned and it is not recommended that
this be done.
2.
If you must clean inside your computer follow the following precautions.
 Be very careful. You can easily damage the computer or hurt yourself.
 Do not touch the chips or other electrical components.
 Use a vacuum cleaner to remove dust carefully.
Use compressed air or the blower option on a vacuum cleaner to blow out dust and other
particles.
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OPERATING SYSTEMS
Introduction
An operating system is system software which is responsible for operating the computer.
Without its help you cannot run any application program on the computer. It manages and
makes optimum use of processor, available hardware, software, input-output system and
memory. It is an interface between the hardware and user.
Basic tasks that an operating system performs are :
1. Process Management – It includes creating, deleting, suspending and resuming
processes, process synchronization and deadlock resolution.
2. I/O System Management – It includes managing the input and output devices.
3. Memory Management – OS allocates various areas of memory to tasks.
4. File Management – Creating, deleting files and directories.
5. Program Execution – OS is responsible for executing various programs.
6. Security – OS maintains security of files stored in memory.
7. Job Scheduling – Which task will be performed when so as to make best use of
CPU is called job scheduling.
Example – DOS, Windows XP, Windows 2000, Linux

DOS
It stands for Disk Operating System. It was designed in 1981 for IBM PC. It uses a command
line interface, which means all commands are entered by typing from keyboard; there are no
menus or graphical components. Hence, it does not need mouse. The file system of DOS can
be understood as a tree structure where a drive contains many directories and files.
As shown in the figure, C is a drive which has three directories – DOS, DATA and WP51.
DATA directory has sub-directory OFFICE. It contains two files memo1.doc and memo.doc.

File – A file is collection of information that you store on a disk. Each file stored in same
directory must have a unique name. a file name has two parts the file name and extension
separated by a dot. Here filename can be of maximum eight characters and extension of three
characters.
Example – myfile.txt, myfile is file name and txt is extension.

Directory – Directories are a collection of files. Every disk has one basic directory called
the root directory. You can create directories in it and they will be called subdirectories.
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Drive – A drive is a single alphabet representing any disk drive attached to computer. Each
drive is represented as different letter. A and B are used for floppy disk drives. C is used for
hard disk. Other partitions and disk drivers can be named as D, E, F and so on.
Pathname – A pathname is a sequence of drive, directory names followed by a file name
which shows exact location of a file. For example – C:\Mydir\myfile.txt – shows that the file
myfile.txt is located in Mydir directory on drive C.

Command – A command is the name of a special program that makes your computer carry
out a task. Every command in DOS is given by typing in through keyboard, at a drive prompt.
By default C prompt (C:\>) is on the screen. The commands in DOS are of two categories :
1.
Internal commands – these are built into the operating system as part of a file
called COMMAND.COM. They are loaded into memory during the booting process.
2.
External commands – They are not built into the operating system, rather are
stored as separate files.

The most common tasks performed through internal commands in DOS
are :
1.
Change the Default Drive – To change the default drive, simply type the letter
of the new drive. It will be listed in subsequent DOS prompts.
Example : C:\>D: [enter] – Changes the default drive from C to D.
D:\>C: [enter] – Changes the default drive from D to C.
2.
Change Directory (CD) – You may move from directory to directory using the
CD command.
Example : C:\>cd furniture [enter] – Moves you to the directory called „FURNITURE‟
C:\>cd\furniture\chairs [enter] – Moves you to the directory called „CHAIRS‟ under the
directory called „FURNITURE‟.
C:\>cd..[enter] – Moves you up one level in the path.
C:\>cd\ [enter] – Takes you back to the root directory (c: in this case).
3.
COPY Command – The COPY command can be used either to copy files from
disk to disk or to create a second copy of a file on a single disk.
Its syntax is COPY <source path> <target path> the first file specified after the COPY
command is the source file, the second is the target file. The source is the file to be copied.
The target will be the location and name of the new file.
Example : C:\> copy c:Kermit.exe d: [enter] – Copies the file „KERMIT.EXE‟ from the C
drive to the D drive and gives it the same name.
C:\> copy a:brazil1.dat d:\south\brazil2.dat [enter] – Creates a copy of „BRAZIL1.DAT‟ from
drive A on drive D, putting it in the „SOUTH‟ subdirectory and renaming it
„BRAZIL2.DAT‟.
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4.

DIR (Directory) Command – The DIRECTORY command lists the names and

sizes of all files located on a particular disk or drive.
Example : C:\> dir a: [enter] – Shows directory of drive A
C:\> dir/w [enter] – Shows directory of C drive in wide format.
C:\> dir/p [enter] – Shows directory of C drive pagewise.
C:\> dir a:*.exe [enter] – Lists all files on the A drive with an extension of „EXE‟.
C:\> dir a:labe?.* [enter] – Lists all five-letter files with the first four letters „LABE‟.
5.
MKDIR (MD) Make Directory Command – This command creates a new
directory. Example : C:\> mkdir mine [enter] – Creates a directory called „MINE‟.
6.
RMDIR (RD) Remove Directory Command – This command removes a
directory. It is only possible to execute this command if the directory you wish to
remove is empty.
Example : C:\> rd mine [enter] – Removes directory called „MINE‟.
7.
RENAME (REN) Command – The RENAME command permits users to
change the name of a file without making a copy of it.
Example : C:\> ren my.txt you.txt [enter] – Changes the name of „MY.TXT‟ to „YOU.TXT‟.
8.
COPY CON – It is used to make new file. Data of the file is typed and it is closed
by Ctrl+Z or F6. If the file already exists old file is replaced.
For example - C:\>COPY CON myfile.txt [enter] – will make a new file with this
name.
9.
CLS – Clear screen. It clears the screen.

10.

DEL – It is used to delete a file. To delete multiple files wild card can be used.

11.

For Example – C:\> del myfile.txt [enter] – will delete the file.
C:\> del *.txt [enter] will delete all files with extension txt.
TYPE – It is used to see data of a file. If file is in current directory mention only
filename, else give full path. For example – C:\> type myfile.txt
EXIT – Used to exit from DOS command console.

12.
13.
14.
15.

TIME – Displays current time setting of system clock. It then asks for new time,
which can be entered if you want to reset time, or just press enter if you don‟t want to
change time.
DATE – Displays current date setting of system clock. It then asks for new date,
which can be entered if you want to reset date, or just press enter if you don‟t want to
change date.
VER – It displays the version of DOS you are using.

Some external commands are :
1.
CHKDSK – Checks a disk and provides a file and memory status report.
2.
DISKCOPY <source> <target> – Makes an exact copy of a disk in source drive to
disk in target drive.
To Start A New Study Centre Under AIYCSM Call 9830654959 or Log in to
www.aiycsmindia.org

25

All India Yuva Computer Saksharata Mission

3.
4.

DISKCOMP <first drive> <second drive> – Compares the contents of two disks.
DOSKEY – Loads the doskey program into memory which recalls your previous

5.
6.
7.

commands. You can use arrow keys to recall a previous command.
EDIT – Starts the MS-DOS editor, a text editor used to create and edit text files.
FORMAT <drivename> – Formats a disk in drive to accept DOS files.
HELP <command> – Displays information about a DOS command.

DELTREE <path> - Deletes all subdirectories and files of a directory.
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Windows XP
What is a desktop?
When you start your computer,
the first thing you see is the
desktop. The desktop is your
work area.
Taskbar
By
default,
the
taskbar
is
located
on the
bottom
edge of the desktop. You can click the taskbar and drug it to other
locations. The Start button, active program buttons, icons for quick
access to programs, and the current time are located on the taskbar.

My Computer

The My Computer icon provides access to the resources on your
computer. You can access your drives and other peripherals by
clicking on the My Computer icon.

Internet Explorer The Internet Explorer icon launches the Internet Explorer browser.
The Recycle Bin When you delete an object, Windows XP sends it to the Recycle Bin.
You can restore objects that are located in the Recycle Bin or you can
permanently delete them.

Shortcut icon

Icons with an arrow in the lower left corner are shortcut icons. Click
the icon for quick access to the object they represent (program,
document, printer and so on).

Program folder and document icons
Program, folder and document icons do not have an arrow in the lower left corner. They
represent the actual object and provide direct access to the object.
How to shut down my computer?
Click the Start button. The Start menu will appear.
Click Turn Off Computer. The Turn Off Computer dialog box will appear.
Click the Turn Off icon. Your computer will shut down.
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How to restart my computer?
You may need to shut down and restart your computer after installing a new program or if
your system becomes unstable. To shut down and immediately restart your computer.
1. Click the Start button. The Start menu will appear.
2. Click Turn Off Computer. The Turn Off Computer dialog box will appear.
3. Click the Restart icon. Your computer will restart.

What is Standby mode?
When your computer is in the Standby mode, your computer consumes less electricity, but is
ready for immediate use. However, if the computer loses electrical power while in the
standby mode, any information you have not saved will be lost.

How to put my computer in Standby mode?
To put your computer in Standby mode :
1. Click the Start button. The Start menu will appear.
2. Click Turn Off Computer. The Turn Off Computer dialog box will appear.
3. Click the Stand By icon.

How to start a program?
To start a program :
1. Click the Start button, located in the lower left corner of your screen.
2. Highlight Programs. The Program menu will appear.
3. Move to the Program menu and highlight the program you want to start. If you see a
right pointer next to your selection, a submenu will appear. Refine your choice by
highlighting the appropriate selection on the submenu. Continue until you get to the
final submenu.
4. Click the program name to start the program.
Note: A chevron at the bottom of the list of options means that there are additional options.
To view the additional options, click the chevron.

How to add an item located on my desktop to the Start or to a Program
menu?
To add an item on the desktop to the Start or to a Program menu :
1. Click and drag the item on top of the Start button.
2. Release the mouse button when the Start menu appears.
3. The item will appear on the Start menu.
4. If you would prefer to have the item on a Program menu or submenu of the Start
menu, drag the item from the Start menu to the Program menu or submenu.
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What is Windows Explorer?
Windows Explorer is a place where you can view the drives on your computer and
manipulate the folders and files. Using Windows Explorer, you can cut, copy, paste, rename,
and delete folders and files.

How to Open Windows Explorer?
To open Windows Explorer :
1. Click the Start button, located in the lower left corner of your screen.
2. Highlight programs.
3. Highlight Accessories.
4. Click Windows Explorer.
Alternatively, you can open Windows Explorer by holding down the Windows key and
typing e (Windows-e).

How to add an item located in Windows Explorer to the Start menu or to a
Program menu?
To add an item located in Windows Explorer to the Start menu or to a Program menu :
1. Click the Start button. The Start menu will appear.
2. Highlight settings. A submenu will appear.
3. Click Taskbar and Start Menu. A dialog box will appear.
4. Click the Start Menu tab.
5. Click the Customize button.
6. Click Add.
7. Type the path to the item you want to add, or use Browse to navigate to the item.
8. Click Next.
9. Double-click an appropriate folder for the item.
10. Click Finish.
11. Click OK.
12. Click OK again. The item will appear on the menu.

How to remove an item from the Start menu or from a Program menu ?
To remove an item from the Start menu or from a Program menu :
1. Click the Start button. The Start menu will appear.
2. Highlight Settings. A submenu will appear.
3. Click Taskbar and Start Menu. A dialog box will appear.
4. Click the Start menu tab.
5. Click Customize.
6. Click the Remove button.
7. Find and click the item you want to remove.
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8. Click the Remove button. You will be prompted.
9. Click Yes.
10. Click Close.
11. Click OK.
12. Click OK again.

How to copy an item that is located on the Start menu or on a Program
menu?
1. Highlight the item.
2. Right-click. A context menu will appear.
3. Click Copy.

How to rename an item on the Start menu or on a Program menu?
1.
2.
3.
4.
5.

Highlight the item.
Right-click the item.
Click Rename. The Rename dialog box will appear.
Type the new name in the New Name field.
Clock OK.

How to delete a file from the Start menu or from a Program menu?
1.
2.
3.
4.
5.

Highlight the item.
Right-click.
Click Delete. You will be prompted.
Click Yes.

How to re-sort the Start or a Program menu?
1. Go to the menu.
2. Right-click.
3. Click Sort By Name.
Note : Some menus cannot be re-sorted.

How to quickly find files and folders?
Windows XP enables you to quickly locate files and folders on your drives. The search
option provides you with four search options : Pictures, music or video; Documents; All files
and folders; and Computers and people. To quickly find a file or folder :
1. Click the Start button. The Start menu will appear.
2. Highlight Search.
3. Click Files or Folders. The Search Results dialog box will open.
4. Choose an option.
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5. Enter your search criteria. Use the table that follows to help you. Click search. The
results of your search will appear in the right pane.

Field
All or part of the file (document) name

A word or phrase in the file

Look In
Specify Dates

Between/During the Previous

Entry Type
Enter the filename, the first few letters of the
filename, or any letters found in the filename.
Use the *as a wild card. For example, to find
all of the files that begin with r and end in the
extension.doc, enter r*.doc. To find files that
begin with resume and have any extension,
enter resume.*.
If you are looking for a file that has a specific
word or phrase in the file, enter the word or
phrase in this field.
Select the drive or folder you want to search.
Select from Modified, Created, or Last
Accessed. Select Modified to find all files
modified since the date criteria you enter,
select Created to find all files created since
the date criteria you enter, or select Last
Accessed to find all files accessed since the
date criteria you enter.
Specify the date search criteria you want to
use. Between allows you to search for files
modified, created, or accessed between two
dates. During allows you to search for files
modified, created, or accessed during the
previous number of days or months you
specify.

What is the Most Recently Used Document list?
As you work, Windows XP tracks the last 15 files you used. It lists these files on the Most
Recently Used Document list. To view the Most Recently Used Document list :
1. Click the Start button.
2. Highlight Documents. The most recently used documents will display.
To open a file listed on the Most Recently Used Document list, click the file name.

How to clear Most Recently Used Document list?
To clear the Most Recently Used Document list :
1. Click the Start button. The Start menu will appear.
2. Highlight Settings.
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3.
4.
5.
6.
7.
8.

Click Taskbar and Start menu. A dialog box will appear.
Click the Start Menu tab.
Click Customize.
Click Clear.
Click OK.
Click OK again.

How to start games?
Several games are included with Windows XP. To access the games :
1. Click the Start button, which is located in the lower left corner of the screen. The Start
menu will appear.
2. Highlight Programs. A submenu will appear.
3. Highlight Games. Another submenu will appear.
4. Click the game you want to play.

How to change the date and/or time?



1. Click the Start button, which is located in the
lower left corner of the screen. The Start menu
will appear.
2. Highlight Settings. A submenu will appear.
3. Click Control Panel. The Control Panel will open.
Click Date/Time. The Date/Time Properties dialog box will appear.
5. In the Date frame, select the month and year.
6. In the Month field, click to open the drop-down menu and select the current month.
7. Type the year in the Year field or use the arrows next to the field to move forward or
backward until you get to the current year.
8. The Time field is divided into four segments : hour, minutes, seconds and AM and
PM. To make an adjustment :
Click in the segment and either type in the correct information or use the arrow keys on
the right side to select the correct hour, minute, second or AM or PM.

Time Zone :
1. Click the Time Zone tab.
2. Choose the correct time zone from the drop-down menu.
3. If you want the clock to automatically adjust to daylight saving time, check the box on
the screen.
4. Click the Apply button.
5. Click OK.

How to install a new printer?
1. Make sure your printer is plugged in, connected to your computer, turned on, and has
paper in it.
To Start A New Study Centre Under AIYCSM Call 9830654959 or Log in to
www.aiycsmindia.org

32

All India Yuva Computer Saksharata Mission
2.
3.
4.
5.
6.

Click the Start button. The Start menu will appear.
Highlight Settings. A submenu will appear.
Click Printers and Faxes. The Printers and Faxes control panel will appear.
Double-click on Add Printer. The Add Printer Wizard will open.
Follow the onscreen instructions.

How to cancel a print job?
1.
2.
3.
4.

Click the Start button. The Start menu will appear.
Highlight Settings. A submenu will appear.
Click Printers and Faxes. The Printers and Faxes control panel will appear.
Double-click the printer to which you sent the print jobs. The Printer window will
open.
5. Click the job you want to stop. If you want to stop more than one job, hold down the
Control key while you click the additional jobs.
6. Click Document, which is located on the menu bar.
7. Click Cancel.

How to temporarily stop selected jobs from printing?
1.
2.
3.
4.

Click the Start button. The Start menu will appear.
Highlight Settings. A submenu will appear.
Click Printers and Faxes. The Printers and Faxes control panel will appear.
Double-click the printer to which you sent the print jobs. The Printer window will
open.
5. Click the document you want to pause. If you want to pause more than one document,
hold down the Control key as you select the additional documents.
6. Click Document, which is located on the menu bar.
7. Click Pause. A checkmark should appear next to Pause.

How to restart print jobs temporarily stopped?
1.
2.
3.
4.

Click the Start button. The Start menu will appear
Highlight Settings. A submenu will appear.
Click Printers and Faxes. The Printers and Faxes control panel will appear.
Double-click the printer to which you sent the print jobs. The Printer window will
open.
5. Click the document you paused. If more than one document has been paused, hold
down the Control key as you select the additional documents.
6. Click Document, which is located on the menu bar.
7. Click Pause. A checkmark next to Pause should disappear.

What is a desktop shortcut?
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A desktop shortcut, usually represented by an icon, is a small file that points to a program,
folder, document, or Internet location. Clicking on a shortcut icons takes you directly to the
object to which the shortcut points. Shortcut icons contain a small arrow in their lower left
corner. Shortcuts are merely pointers. Deleting a shortcut will not delete the item to which the
shortcut points.

How to create a desktop shortcut?
To create a shortcut to an item located on the Start menu :
1. Click Start. The Start menu will appear.
2. Locate the item to which you want to create a shortcut. If the item is located on a
submenu, go to the submenu.
3. Click and drag the item to your desktop.
To create a shortcut to items visible in Windows Explorer :
1. Open Windows Explorer.
2. Locate in Windows Explorer the item to which you want to create a shortcut.
3. Click the right mouse button. A context menu will appear.
4. Click Create Shortcut Here.

How to turn a Web link into a desktop shortcut?
To turn a Web link into a desktop shortcut, click the link in your browser window (usually
underlined text) and drag it to the desktop. An icon will appear on your desktop. When you
click the icon, your browser will open and you will go directly to the Web page.

How to delete a desktop shortcut?
1. Click the shortcut.
2. Press the Delete key.
3. Click Yes.

How to change the icon associated with an object?
To change the icon associated with an object :
1. Right-click the icon. The context menu will appear.
2. Click Properties.
3. Click the Change Icon button.
4. Click the icon of your choice.
5. Click OK.
Note : Not all icons can be changed. If you do not see the Change Icon button, the icon
cannot be changed.

What is wallpaper?
Wallpaper is the background that displays on your desktop.
To change your wallpaper :
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1.
2.
3.
4.

Right-click your desktop.
Highlight Properties.
Click the Desktop tab.
Select the wallpaper you want from the list that appear in the Background box.
Note : If you would like to display an image you created, you can click Browse to
find the image.
Select how you want your image to appear on the screen. Choose from the following :
Center
Place the image in the center of the screen.
Tile
Have the image display as tiles across and down the screen.
Stretch
Stretch the image so the image covers the entire screen.

What is a font?
A font is a set of characters represented in a single typeface. Each character within a font is
created by using the same basic style. Fonts are measured in points. There are 72 points to an
inch. The number of points assigned to a font is based on the distance from the top to the
bottom of its longest character.

How to install a new font?
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click the Start button.
Highlight Settings.
Click Control Panel.
Click Fonts. The Fonts window will open.
Click File, which is located on the menu bar.
Click Install New Font.
Specify the drive and folder where the font you want to install is currently located.
Select the font you want to install from the fonts listed in the List of Fonts box.
Select Copy Fonts to Fonts Folder (this will put a copy of the font you are installing in
the Fonts folder).
10. Click OK.

What is the Character Map?
The Character Map displays the characters available in a selected font.
1. Click the Start button.
2. Highlight Programs.
3. Highlight Accessories.
4. Highlight System Tools.
5. Click Character Map.
The dialog box shown here will be displayed.
Select a font from the Font field drop-down menu. The characters of the font are in boxes in
the center of the window. Click a character box to display an enlarged version of the
To Start A New Study Centre Under AIYCSM Call 9830654959 or Log in to
www.aiycsmindia.org

35

All India Yuva Computer Saksharata Mission
character. The keystroke necessary to produce
the character displays in the lower left corner
of the screen. Double-click a character or
select the character; then click the Select
button to send the character to the Characters
to Copy field. Click the Copy button to move
the Characters to Copy field contents to the
Clipboard.

What are drives?
Drives are used to store data. Almost all computers come with at least two drives : a hard
drive and a CD drive. The hard drive is typically designated the C:\ drive and the CD drive is
typically designated the D:\drive. If you have an additional floppy drive, it is typically
designated the A:\drive. If your hard drive is partitioned or if you have additional drives, the
letters E:\, F:\, G:\ and so on are assigned.

What are folders?
Folders are used to organize the data stored on your drives. You will want to organize the
files you create in folders.
You will want to store files
of same kind in a single
folder. It is same as you
arrange similar documents,
like marksheets, bills in a
file cover and name it. The
documents can be seen as
files and file cover as
folder.
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How does Windows XP organize files and folders on drive?
Windows XP organizes folders and files in a hierarchical system. The drive is the highest
level of the hierarchy. A diagram of a typical drive and how it is organized is shown here.
At the highest level, you have some folders and perhaps some files. You can open any of the
folders and put additional files and folders into them. This creates a hierarchy.

What is Windows Explorer window ?
When you open Windows Explorer, the screen shown here will appear.
Windows XP separates the window into two panes. If you click an object in the left pane, the
contents of the object display in the right pane. Click Desktop and the contents of the
Desktop folder display on the right. Click My Computer and your computer resources display
on the right. To see the contents of a drive, click the drive. To see the contents of a folder,
click the icon for the folder in the left pane.

How to create a new folder when in Windows Explorer?
1.
2.
3.
4.
5.

In the left pane, click the driver or folder in which you want to create the new folder.
Click any free area in the right pane. A context menu will appear.
Highlight New.
Click Folder.
Type a name for the folder.

What are Windows Explorer views?
Views control how Windows Explorer displays information in the right pane. Windows
Explorer provides you with the following choices: Thumbnails, Tiles, Icons, List and Details.
 Thumbnails view displays images. These images represent the contents of folders
and files. For example, if a folder contains pictures, up to four of the pictures in the
folder will be displayed on the folder icon.
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Tiles view and Icons view display icons to represent drives, folders and the contents
of folders. The icons displayed when you choose Tiles view are larger than the icons
that display when you choose Icon view.
List view displays all of the files and folders without supplying the size, type or date
modified.
Details view displays the size, type and date modified.

To change the view:
1. Right-click any free area in the right pane. A context menu will appear.
2. Highlight View.
3. Select the view you want from the drop-down menu.

How to delete a file or folder?
1. Right-click the file or folder you want to delete. A context menu will appear.
2. Click Delete. Windows Explorer will ask, “Are sure you want to send this object to
the recycle bin?”
3. Click Yes.

How to copy a file or folder?
1. Right-click the file or folder you want to copy. A context menu will appear.
2. Click Copy. The file or folder should now be on the Clipboard.

How to cut a file or folder?
1. Right-click the file or folder you want to copy. A context menu will appear.
2. Click Copy. The file or folder should now be on the Clipboard.
Note : Cutting differs from deleting. When you cut a file, the file is placed on the Clipboard.
When you delete a file, the file is sent to the Recycle Bin.

How to paste a file or folder?
1. After cutting or copying the file, right-click the object or right-click in the right pane
of the folder to which you want to paste. A context menu will appear.
2. Click Paste.

How to rename a file or folder?
1. Right-click the file or folder. A context menu will appear.
2. Click Rename.
3. Type the new name.

What is a screen saver?
Computer monitors display images by firing election beams at a phosphor-coated screen. If
the same image stays on the screen too long, there is a danger that the image will leave a
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permanent imprint on the screen. Screen savers help prevent this by providing a constantly
changing image.

How to select a screen saver?
To select a screen saver :
1. Right-click anywhere on the Windows desktop. A context menu will appear.
2. Choose Proprieties. The Display Properties dialog box will appear.
3. Click the Screen Saver tab.
4. The Screen Saver field provides the list of available screen savers. Select the screen
saver you want from the list.
5. Click Preview to preview your screen saver.
6. Click Esc to return to the Display Properties dialog box.
7. In the Wait field, set the number of minutes of inactivity before the screen saver
starts.
8. Click OK.

What is a window?
A window is an area on your desktop within which all Windows-based programs run.
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Control Box
Boarder

Title bar
Minimize
button
Maximize
button
Restore button
Close button
Menu bar
Toolbars

Work area
Status bar

The control box provides a menu that enables you to restore, move, size,
minimize, maximize, or close a window.
The border separates the window from the desktop. You resize the
window by dragging its borders outward to expand it and inward to
contract it.
The title bar displays the name of the current file and the name of the
current program.
Use the Minimize button to temporarily decrease the size of a window or
remove a window from view. While a window is minimized, its title
appears on the taskbar.
Click the Maximize button and the window will fill the screen.
After you maximize a window, if you click the Restore button, the
window will return to its former size.
Click the Close button to exit the window and close the program.
The menu bar displays the program menu. You send commands to the
program by using the menu.
Toolbars generally display right below the menu, but you can drag them
and display them along any of the window borders. You use the icons on
the toolbars to send commands to the program.
The work area is located in the center of the window. You perform most
of your work in the work area.
The status bar provides you with information about the status of your
program.

How to switch between windows?
If you have several windows open at the same time, the window on top is the window with
focus. You can only interact with the window with focus. To change windows, do one of the
following:
1. Click anywhere on the window you want to have focus.
2. Hold down the Alt key and press the Tab key (Alt-Tab) until you have selected the
window to which you want to change.
3. All active files display on the taskbar. Click the taskbar button for the window you
want to have focus.

How to move a window around on desktop?
To move a window around on your desktop, left-click the window‟s title bar and drag the
window.
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What does it mean to “cascade windows”?
Cascading your windows is a way of organizing your windows on your desktop. Cascading
windows fan out across your desktop with the title bar of each window showing.
1. Right-click the taskbar. A menu will appear.
2. Click Cascade Windows.

What does it mean to “tile windows”?
Tiling your windows is a way of organizing your windows onscreen. When you tile your
windows, Windows XP places each window on the desktop in such a way that no window
overlaps any other window. You can tile your windows horizontally or vertically.
1. Right-click the taskbar. A menu will appear.
2. Click the Windows Horizontally or Tile Windows Vertically, whichever you prefer.

What are scrolling?
In many programs, if the contents of the work area do not fit in the window, scrollbars will
appear. A vertical scrollbar will appear at the right side of the window and a horizontal
scrollbar at the bottom of the window, depending on the fit. The vertical scrollbar provides a
way to move up and down. The horizontal scrollbar provides a way to move from left to
right.
The scroll box indicates where you are in your document. If the scroll box is at the top of the
scrollbar, you are at the top of the document. If the scroll box is in the center of the scrollbar,
you are in the center of the document.

To move up and down one line at a time :


Click the arrow at either end of the vertical scrollbar.

To move from side to side one character at a time :


Click the arrow at either end of the horizontal scrollbar.

To move approximately one window at a time :



Click above the scroll box to move up.
Click below the scroll box to move down.

To scroll continuously :


Click the appropriate arrow and hold down the mouse button.

To move to a specific location :


Left-click the scrollbar and hold down the left mouse button until you arrive at the
location. For example, if you want to go to the center of the document, click the
center of the scrollbar and hold down the left mouse button.
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Or, drag the scroll box until you arrive at the desired location.

What is an icon?
An icon is a graphic image. Icons help you execute commands quickly. Commands tell the
computer what you want the computer to do. To execute a command by using an icon, click
the icon.

What is a menu?
Menus provide a way for you to send commands to the computer (tell the computer what you
want the computer to do). When you open a window, menu options are listed from left to
right just below the title bar on the menu bar. When you click a menu item, a drop-down
menu appears. Select the command you want to execute from the drop-down menu. An
ellipsis(…) after a drop-down menu item signifies that there are additional options; if you
select that option, a dialog box will appear.

What is a shortcut key?
You can use shortcut keys to execute a command quickly by pressing key combinations
instead of selecting the commands directly from the menu or clicking on an icon. When you
look at a menu, you will notice that most of the options have one letter underlined. You can
select a menu option by holding down the Alt key and pressing the underlined letter. You can
also make Alt-key selections from drop-down menus and dialog boxes.

Universals that Apply to almost all Programs
The following list applies to many Windows-based applications :
Shortcut
Key

Menu
Path

Command Description

Ctrl-N

File>
New

Create a new file.

Ctrl-O

File>
Open

Open an existing file.

Ctrl-S

File>
Save

Save the current file.

Ctrl-P

File>
Print

Print the current file.

Ctrl-F

Edit>
Find

Find text in the current document.

Ctrl-X

Edit>
Cut

Cut (delete and place on Clipboard) the
current selection

Ctrl-V

Edit>
Paste

Place the material currently on the
clipboard in the file at the current location.

Ctrl-C

Edit>
Copy

Copy the current selection to the clipboard.
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Ctrl-Z

Edit>
Undo

Reverse the most recent command. Place
the program in the state it was in before
executing the last command

Ctrl-V

Edit>
Redo

Reverse the last undo. Place the program
in the state it was in before executing
Undo.

Format>
Font

Apply a font to the current selection.

Format>
Font

Set the size of the font for the current
selection.

Ctrl-B

Format>
Font

Bold the current selection.

Ctrl-I

Format>
Font

Italicize the current selection.

Ctrl-U

Format>
Font

Underlined the current selection.

Ctrl-L

Left-align the selection.

Ctrl-R

Right-align the selection.

Ctrl-E

Center the selection.

Ctrl-J

Justify the selection.
View>
Toolbars

Select the toolbars you want to display.

What is a selection?
A selection is a highlighted area on which you can perform a command. For example, if you
are using a word processing program, you can highlight a word and then execute the
Underline command to underline the highlighted word.

How to make a selection?
To make a selection:
1. Left-click where you want to start your selection.
2. Hold down your left mouse button and drag the mouse until you have highlighted the area
you want.
Or
1. Left-click where you want to start your selection.
2. Hold down the Shift key while you use the arrow keys to highlight the area that you want.
Note : Typing over highlighted text replaces the old text with the new text you type.
Cut : When you cut something, it is deleted from its current location and saved to the
Clipboard. Information saved to the Clipboard stays there until new information is either cut
or copied. Each time you execute Cut or Copy, you replace the old information on the
clipboard.
Clipboard : The Clipboard is the storage area for items that have been cut or copied. Each
time you execute Cut or Copy, you replace the old information on the Clipboard with
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whatever you just cut or copied. You can paste Clipboard information as often as you like,
until you replace it with something else.

What is a dialog box?
Whenever you see an ellipsis (…) after a menu option, selecting that option causes a dialog
box to appear. You use dialog boxes to send commands to the computer. Most dialog boxes
provide an OK button and a Cancel button. Press OK button if you are satisfied with your
entries and you want to send the commands to the computer. Press the Cancel button if you
have changed your mind and do not want to send the commands to the computer.

What are tabs?
Some programs provide dialog boxes with several pages of options. You move to a page by
clicking on the tab or by using Ctrl-Tab (hold down the Ctrl key while pressing the Tab key
to flip through the pages).
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WINDOWS ACCESSORIES & UTILITIES
There are several accessories and utilities provided in Windows Operating System which you
can use for your convenience
1. Notepad
2. Calculator
3. Paint
4. Command Prompt
5. Disk Defragmenter
6. System restore
7. Windows Media Player

Notepad
It is used to write simple text files. The text has no formatting. You can create new files, open
existing ones and save the files. The files have extension.txt. Since the size of the file is very
small, it is useful to note down several things as simple text. It is similar to a notepad you
have for personal use to take down short notes on any topic. To use a notepad.
1. Click Start
2. Select All programs  Accessories  Notepad
The Notepad window looks like as shown in figure:
Since it is a window, it has menus.
1.
File Menu – used for creating new files, closing, opening and saving files. You can
even print files.
2.
Edit Menu – It is used for simple edit operations like cut, copy, paste, find, undo and
select all.
3.
Format Menu – It can be used to format font or to turn word wrap on/off.
4.
View Menu – It is used to view status bar.
Help Menu – It is used to take help from Windows about using Notepad.

Calculator
Just as a calculator is used for calculations,
Windows provides an application which can be used
for calculations. To use a calculator:
1. Click Start
2. Select All programs  Accessories 
Calculator
It is used in the same manner as a calculator, by
clicking on buttons to press them. The text box is
used to display numbers and the result. Instead of
using buttons same numbers and operators can be entered from keyboard. The edit menu has
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only two options – copy and paste. The calculator window can have two views – standard and
scientific. Standard view resembles ordinary calculator. Scientific view resembles a scientific
calculator which can also perform binary, hexadecimal and octal arithmetic.
The Window looks like given below;
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Paint
Windows provides an accessory to make small drawings of your own. They can be made
freehand, or by using definite shapes and you can fill colors in them. To use Paint :
1. Click Start
2. Select All programs  Accessories  Paint
The Window looks like given below :
It is also a menu-driven application. It also has a toolbox with tools to draw – definite shapes,
geometric shapes, freehand drawing, write text, fill color, erase, spray paint and make straight
lines. Using these tools you can make a drawing of your own it also has a color box so that
you can select the color of your choice for lines or for filling.
1.
File Menu – Anything you draw in blank area is treated as a file and hence you can
create a new file, save a file, open previous file and close a file using File Menu.
2.
Edit Menu – Simple edit options are available here.
3.
View Menu – It is used if you want to turn on/off view of toolbox, color box and
status bar.
4.
Image Menu – It provides interesting options for your drawing.
5.
Colors – It works same as Color Box.
6.
Help – It provides help on use of Paint.
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Command Prompt
It is used to switch into DOS environment. To start it, do the following :
1. Click Start
2. Select All programs 
Accessories

Command Prompt
A window will open where you
will see the DOS prompt. Here
you can type DOS commands.
Though it has a close button,
you should type exit command
to close it.

Disk Defragmenter
It is a very useful tool. Your hard disk should be defragmented time to time to keep your
system in better working condition. It is like cleaning and organizing your file cabinet. All
files are shifted such that they can be clustered in unused area and large blocks of memory
can be made available free.
To run defragmenter, do
1. Click Start
2. Select All programs  Accessories  System Tools  Disk Defragmenter.
Here you can select the drive you
want to defragment. You must not
change anything in the drive while
defragmentation process is going on.
It takes time to complete and one
must be patient enough.

System Restore
It is a very useful tool. If you notice some odd behavior in your computer you can restore its
settings back to a point in past. The system restore tool restores the settings of computer to an
old date. The date and timings or data in files are not changed, only the settings of operating
system are changed. To use this tool, do
1. Click Start
2. Select All programs  Accessories  System Tools  System restore.
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You can also create a restore point if you want to save current settings of the computer. The
system restore wizard guides you through each step.
If system restoration does not solve your problem, you can even undo your last restoration.

Windows Media Player
Windows provides an application for running media files so that you can hear songs and
watch movies. To use this application.
1. Click Start
2. Select All programs 
Accessories

Entertainment

Windows Media Player
It is also a menu-driven application.
A media file can be opened or closed.
You can also make a playlist of
several files and then play them. A
playlist is simply a list of files to be
played in sequence. This application
has all controls similar to a CDplayer or DVD-player. It has all
common controls of volume, voice balancing, forward, reverse, seek, next file, previous file
etc.
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